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Preface

Welcome to Release 11i of the Oracle E-Business Intelligence Embedded Data Warehouse 
Install Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ If you have never used Oracle E-Business Intelligence, Oracle suggests you 
attend one or more of the Oracle Applications training classes available through 
Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
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How To Use This Guide
This guide contains the information you need to understand and use Oracle 
E-Business Intelligence. These user notes includes:

■ Chapter 1, "Introduction" provides an overview of Oracle E-Business 
Intelligence and Embedded Data Warehouse.

■ Chapter 2, "Installation Tasks" describes how to install Oracle E-Business 
Intelligence Embedded Data Warehouse.

■ Chapter 3, "Upgrade Tasks" describes how to upgrade from previous releases of 
Oracle E-Business Intelligence Embedded Data Warehouse.
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Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 
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Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle E-Business Intelligence.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ Online Help - The new features section in the HTML help describes new 
features in 11i. This information is updated for each new release of Oracle 
E-Business Intelligence. The new features section also includes information 
about any features that were not yet available when this guide was printed. For 
example, if your administrator has installed software from a mini-packs an 
upgrade, this document describes the new features. Online help patches are 
available on MetaLink.

■ 11i Features Matrix - This document lists new features available by patch and 
identifies any associated new documentation. The new features matrix 
document is available on MetaLink.

■ Readme File - Refer to the readme file for patches that you have installed to 
learn about new documentation or documentation patches that you can 
download.

Related Guides
Oracle E-Business Intelligence shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other guides 
when you set up and use Oracle E-Business Intelligence.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
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Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle E-Business 
Intelligence (and any other Oracle Applications products). This guide also includes 
information on setting user profiles, as well as running and reviewing reports and 
concurrent processes.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product user 
guides and implementation guides.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.
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Maintaining Oracle Applications Documentation Set
This documentation set includes Oracle Applications AD Procedures Guide and Oracle 
Applications AD Utilities Reference Guide. 

Use these guides to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. They contain how-to steps, screenshots, and other information that you need 
to run the AD utilities. These guides also provide information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
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between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes. You also 
use this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle E-Business Intelligence implementation team, as well as for users responsible 
for the ongoing maintenance of Oracle Applications product data. This guide also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
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Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle E-Business Intelligence and reach full productivity quickly. These courses are 
organized into functional learning paths, so you take only those courses appropriate 
to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle E-Business Intelligence 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.
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Do Not Use Database Tools to Modify Oracle Applications 
Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
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applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using Oracle E-Business Intelligence and these user notes.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle E-Business 
Intelligence or this user guide. Mail your comments to the following address or call 
us directly at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
xviii                                                                                         
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Introduction

This chapter contains an overview of Oracle E-Business Intleligence and Embedded 
Data Warehouse. It includes the following topics.

■ Overview of E-Business Intelligence on page 1-2

■ Overview of Embedded Data Warehouse on page 1-2

■ E-Business Intelligence Architecture on page 1-4

■ Embedded Data Warehouse Architecture on page 1-4
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Overview of E-Business Intelligence
Overview of E-Business Intelligence
In becoming e-businesses, organizations have streamlined their internal processes 
to win new customers and to gain a larger share of their existing customers’ 
business.  New, internet-enabled, enterprise application suites and electronic market 
places are reducing inefficiencies across supply chains while providing new 
opportunities to improve customer relationships.  As organizations adopt these new 
solutions, the need to make decisions faster has also increased. To remain 
competitive, every organization must empower more people to make informed 
decisions, without the need for long approval or review cycles. 

To meet this challenge, organizations must provide the relevant business 
information and analysis tools that every manager or project team needs to quickly 
understand what is happening, to be able to analyze alternatives, and to take action.  
Business intelligence applications are available to provide the data and analysis 
required to make these decisions, but most business intelligence products are not 
integrated with operational systems.  Because the business processes underlying 
source applications are always changing, traditional business intelligence 
applications cannot easily gather the necessary data or transform it into useful 
management information.

Oracle Business Intelligence with the Embedded Data Warehouse (EDW) provides a 
simple and powerful framework for delivering information, from internal 
applications and external sources, to end-users across the enterprise.  EDW unlocks 
the value of information, held in operational systems, by automatically collecting, 
aggregating and transforming source data, to provide secure access and a unified 
view of the entire organization.  With the Business Intelligence applications, 
everyone has immediate access to accurate and timely data to make faster and more 
informed decisions, which leads to a positive impact on bottom line results.

Overview of Embedded Data Warehouse
The Embedded Data Warehouse (EDW) is a foundation technology for Oracle 
Business Intelligence applications. This ready-to-run, end-to-end solution provides 
an open schema and extensible data warehousing architecture, powered by robust 
data warehousing tools. EDW:

■ Gives users a unified view of the enterprise with its cross-functional analysis 
capabilities

■ Leverages a common dimension model which enables seamless cross-functional 
analysis across the entire enterprise
1-2 Oracle E-Business Intelligence Embedded Data Warehouse Install Guide



Overview of E-Business Intelligence
■ Includes fact tables from 7 intelligence areas: Financials, Projects, Purchasing, 
Manufacturing, Marketing, Human Resources, and Supply Chain

■ Provides shorter time-to-benefit with its pre-defined enterprise schemas and 
hierarchies, and pre-built data collection and integration programs

EDW, the enabling technology of Oracle Business Intelligence, unleashes the power 
of e-business insight, not just information.
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E-Business Intelligence Architecture
E-Business Intelligence Architecture 
E-Business Intelligence is designed to support a multi-tiered architecture. 

The first tier, the database tier, provides the foundation technology. The database 
tier can be implemented as a transactional (OLTP) or a warehouse (OLAP) schema. 
The transactional schema provides users with real-time report data. The warehouse 
schema provides users with summarized data that supports more complex 
reporting and decision making. The type of schema you choose determines the type 
of content that is available to your users.

The second tier, the applications tier, provides the load balancing and business 
logic. It processes requests from the third tier (client tier) and sends results from the 
database tier to the client tier. 

The third tier, the client tier, supports user activities such as reporting from the web, 
and administration.

If you are installing EDW, you are implementing Business Intelligence using the 
warehouse schema. 

Embedded Data Warehouse Architecture
Physically, EDW divides the Business Intelligence  architecture between two types 
of systems: one or more source systems and one target system.

A source system can be any Oracle Applications system, non-Oracle system running 
on an Oracle database, or legacy database application that provides data to the 
warehouse. You can use one or more source systems to provide data to the target 
system. 

The target system is the runtime warehouse. There is only one target system. It 
integrates data from multiple source systems, transforms the data, and makes it 
available in a star schema design. The star schema design supports complex user 
reporting and decision making. 

Additional Information: For more information on Oracle 
Applications and multi-tier architecture, see Oracle Applications 
Concepts.
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E-Business Intelligence Architecture
Source System Components
Source systems can be any Oracle Applications Release10.7, 11, or 11i system; 
non-Oracle system running on an Oracle database; or legacy database application 
that provides data to the warehouse. Each source system must contain the following 
components.

■ Database links: Database links are used to connect the source system to the 
warehouse and from the warehouse to the source system. 

■ Interface tables: For EDW, source system data is put into interface tables before 
it is pushed to the warehouse.

■ Collect programs: Collect programs determine how to extract and transform 
source data for the warehouse. Collect programs use the database links to 
transfer data from the interface tables to the warehouse and from the 
warehouse to the source system.

■ Concurrent Manager: The concurrent manager coordinates the processes 
generated by users’ requests to run various data-intensive programs. 

■ Web Browser: A web browser is used with Oracle Applications 11i source 
systems. This is only necessary on an Oracle Applications 11i source system.

These components must be installed and set up on each source system. 

Target System Components
The target system is an Oracle Applications Release 11i.3 system (or higher) with an 
Oracle 8i or 9i database. The target system summarizes data from the various source 
systems into a data warehouse (from this point forward, this document will refer to 
the target system as the warehouse). The warehouse contains fact tables, dimension 
tables, APIs, and other supporting utilities and objects. It must also contain the 
following components:

■ Load programs: Load programs use the EDW metadata to determine how to 
move data into the warehouse. Load programs transfer data from interface 
tables to warehouse schema.

■ Database Links: Database links are used to connect the source system to the 
warehouse and from the warehouse to the source system. 

■ EDW Metadata: The EDW metadata defines the contents of the runtime 
warehouse: the facts, dimensions, and other objects. The loader engine uses the 
metadata to define how to move data into the warehouse schema. The reporting 
and analytical tools also use the metadata. 
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E-Business Intelligence Architecture
■ Oracle Discoverer End User Layer: The Oracle Discoverer End User Layer 
(EUL) is a schema that sits on the warehouse database. This schema is used to 
access the workbooks. Workbooks and the EUL must reside on the database tier 
of the warehouse. 

■ Oracle Discoverer Workbooks: Workbooks enable users to analyze the 
summarized data in the warehouse. Workbooks access data through the Oracle 
Discoverer EUL. Workbooks and the EUL must reside on the database tier of 
the warehouse. 

■ Oracle Warehouse Builder Repository: The Oracle Warehouse Builder (OWB) 
repository resides on the database tier of the warehouse. This repository stores 
the EDW metadata. 

■ Interface tables: For EDW, source system data is loaded into interface tables 
before it is transformed into the star schema on the warehouse.

■ Concurrent Manager: The concurrent manager coordinates the processes 
generated by users’ requests to run various data-intensive programs. 

■ Forms Server: The Forms Server is automatically installed as part of the Oracle 
Applications 11i.3 (or higher) Rapid Install.

■ Oracle Discoverer 4i Web Client: The Oracle Discoverer 4i Web Client is 
installed as a separate application. The client contains a web browser with the 
Oracle Discoverer Web Client plug-in that executes the workbooks. 

■ Self Service Web Applications: Self Service Web Applications is automatically 
installed as part of the Oracle Applications 11i.3 (or higher) Rapid Install. .

■ Zip utility: This utility is used to extract compressed files.

■ Oracle Warehouse Builder Client: The OWB client provides front-end access to 
the OWB repository. The OWB client must be installed on a Windows NT/2000 
machine. It is the recommended tool for viewing the EDW metadata. 

■ Oracle Discoverer Bridge Client: The Oracle Discoverer Bridge client is used to 
create the EUL from the EDW metadata. The bridge is installed as part of the 
typical Oracle Warehouse Builder install. The bridge can reside on the same 
physical machine as the OWB client.

■ Oracle Discoverer Administration Client: The Oracle Discoverer 
Administration client is installed as a separate application. The client is used for 
administration of the Oracle Discoverer EUL. You use this client to import the 
EUL and configure security for Oracle Discoverer. The Oracle Discoverer 
Administration client must be installed on a Windows NT/2000 machine.
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E-Business Intelligence Architecture
■ Web Browser: A web browser is used to view warehouse data.

■ Performance Management Framework components: The following is a list of 
the components that comprise the Performance Management Framework.

■ Presentation components: The Performance Management Graph Portlet 
allows end users to display graphs from the Performance Management 
Viewer reports.  Through customization of this portlet the end user can 
choose a report and parameters for display.

The Performance Management List portlet allows end-users to view 
performance information from the personal homepage.  Through 
customization of this portlet, an end user can choose measures and 
parameters.  The actual values will display, with red color coding if the 
actual value falls outside of the tolerance range.  The values of the measure 
are calculated through  the processing of Alerts.   

Through the Business Intelligence Performance Management Viewer, end 
users have access to a set of pre-built reports that are specifically tailored to 
intelligence users.  These reports provide an intuitive user interface and 
features aimed at the novice end user.  Note that previous versions of BIS 
used Oracle Reports to define and render reports.  In this release, Business 
Intelligence uses its own Performance Management Viewer technology.

Through Oracle Workflow, users receive notifications.  Business Intelligence 
uses notifications for alerting users to out of tolerance situations for 
measures with targets.  

■ Definition components: The AK Repository is a metadata repository used 
for the definition of application common data.  For Business Intelligence we 
use the AK Repository in defining Performance Management Viewer 
reports and Performance Measures.  This definition contains layout 
information for the reports and establishes the source of actual values for 
both the reports and performance measures.    

The Performance Management Framework contains a set of forms to define 
performance measures and the dimension levels.  These forms allow 
administration users to assign the dimensions, security, corrective actions 
and automated target retrieval.  Note that a measure also needs setup in the 
AK repository to enable the retrieval of actual values. 

■ Responsibilities: The following responsibilities are used for setting up the 
Performance Management Framework:  Performance Management 
Framework (Full Access), Performance Management Framework (Targets 
Access), BIS Super User. 
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The following responsibilities contain Performance Management Viewer 
Reports: Purchasing Intelligence - Embedded Data Warehouse, Supply 
Chain Intelligence - Embedded Data Warehouse, Manufacturing 
Intelligence - Embedded Data Warehouse.

■ Data components: For Business Intelligence Reports and Performance 
Measures, intelligence teams have built a set of Views on top of the EDW 
fact tables.  These views are optimized for use by the Viewer Reports and 
Performance Measures.

The Performance Management Framework contains a set of forms for use in 
entering and maintaining target information on performance measures.  
This includes target values, tolerance ranges and target owners.

■ Processing components: Through the Performance Management 
Framework, administration users can schedule alerts and target users can 
subscribe to the notifications.  Schedule Alerts will send notifications to 
target owners and update data for presentation on the performance 
measure portlet.  Note that previous versions of BIS utilized Oracle Alerts 
to achieve the alerting functionality.  In this release, Business Intelligence 
contains its own alerting technology. 
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Installation Tasks

This chapter describes how to install and configure Oracle E-Business Intelligence 
Embedded Data Warehouse (EDW). This chapter covers the following topics.

■ Overview of Installing the EDW Repository and EUL on page 2-2

■ Verify Prerequisites on page 2-4

■ Set Up Database Links on page 2-6

■ Install Oracle Warehouse Builder 9i and Repository on page 2-10

■ Check Validation Point on page 2-20

■ Create the EDW EUL and Import EDW Workbooks on page 2-21

■ Configure Security on page 2-27

■ Backup Source Systems and Warehouse on page 2-32 
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Overview of Installing the EDW Repository and EUL
This chapter describes how to install the EDW repository and end user layer (EUL). 
Some of the steps in this installation are dependent on particular hardware or 
software being installed and configured before you begin. Some of the steps are 
optional, must be performed in a particular order, or require that you validate the 
step with your implementation team. 

To avoid unexpected delays in the installation, please read through this entire 
install guide and familiarize yourself with the install process before you begin.  

The following table contains a checklist that you can use when installing EDW.

Important: It is highly recommended that this installation be 
performed by an Oracle Applications database administrator in 
cooperation with the implementation team.

Table 2–1 Installation Steps

Step Location Task List

Verify Prerequisites on 
page 2-4

Source Systems

Warehouse System

Administration Client

■ Hardware Prerequisites

■ Software Prerequisites

■ Tablespace Prerequisites

Set Up Database Links on 
page 2-6

Source Systems

Warehouse System

■ Set Up Links from Warehouse to 
Source Systems

■ Set Up Links from Source Systems 
to Warehouse

■ Set Up Database Links for 
Single Instance EDW

Install Oracle Warehouse 
Builder 9i and Repository 
on page 2-10

Warehouse System ■ Install Oracle Data Warehouse 
Builder 9i. For more information, 
see the Oracle 9i Warehouse Builder 
Installation Guide Release 9.2.0.2.8.

■ Install OWB Repository
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Check Validation Point on 
page 2-20

Warehouse ■ Check Validation Point, for more 
information see Oracle Embedded 
Data Warehouse Implementation 
Guide:

■Complete flexfield mapping 
(optional)

■Complete user defined attribute 
mapping (optional)

■Complete modification of 
metadata (optional)

Create the EDW EUL and 
Import EDW Workbooks on 
page 2-21

Discoverer 4i 
Administrative Client 
machine

Warehouse System

■ Create the EUL

■ Generate the EDW EUL EEX File, 
for more information see Oracle 
Embedded Data Warehouse  
Implementation Guide

■ Import the EDW EUL EEX File

Configure Security on 
page 2-27

Discoverer 4i 
Administrative Client 
machine

Warehouse System

■ Grant Users/Responsibilities 
Access to Oracle Discoverer 4i User, 
or Administration Client. For more 
information, see the Oracle 
Discoverer documentation.

■ Grant Users/Responsibilities 
Access to Business Areas

■ Transfer EDW Discoverer 4i 
Contents to Windows NT/2000/XP 
Client

■ Define Default Profile Options

Backup Source Systems and 
Warehouse  on page 2-32

Source Systems

Warehouse System

■ Backup data on source systems and 
warehouse (optional)

Table 2–1 Installation Steps

Step Location Task List
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Verify Prerequisites
Before you begin to install EDW, you must verify that all hardware and software 
prerequisites have been met.

This section contains the following topics.

■ Hardware Prerequisites

■ Software Prerequisites

■ Tablespace Prerequisites

 Hardware Prerequisites
To successfully complete the installation, you must have the following hardware 
available.

Source Systems
For information on hardware requirements for your 11i source systems, see the 
installation documentation for the respective system.

Warehouse
For the hardware requirements for the database, see Oracle 8i(9i) Installation Guide. 

For the hardware requirements and supported platforms for Oracle Discoverer, see 
Oracle Discoverer 4i Installation Guide. 

For the hardware requirements for Oracle Applications 11i see Installing Oracle 
Applications 11i.

Administrative Client
For the hardware requirements for Oracle Warehouse Builder Client, see Oracle 9i 
Warehouse Builder Installation Guide Release 9.2.0. The OWB Client is installed into 
Oracle 8i home on a Windows NT/2000/XP machine. The Windows NT/2000/XP 
server should have at least 1 GB of RAM and 2 GB of space for installing the OWB 
Client and converting the OWB metadata repository.

 Software Prerequisites
To successfully complete the install, you must have the following software available 
on the source system and warehouse servers.
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Source Systems
You must have one or more of the following standard source systems. For 
information on the standard install for each source system, see the appropriate 
installation documentation.

■ Oracle Applications Release 11i with patch set 3 or higher

You must also have the EDW Release 4.2 mini-pack, with the source patchset 
(11i.EWS.D) installed on each source system. For more information see About Oracle 
Embedded Data Warehouse for Release 4.2 on Oracle MetaLink.

Warehouse
You must have the following standard warehouse system. For information on the 
install for the warehouse system, see the appropriate installation documentation.

■ Oracle Applications Release 11i with patch set 3 or higher

You must also have the EDW Release 4.2 mini-pack, with the warehouse patchset 
(11i.EDW.D) installed on the warehouse system. For more information see About 
Oracle Embedded Data Warehouse for Release 4.2 on MetaLink.

For RDBMS 8i only, update your init.ora parameter file with the following 
initialization parameters:

star_transformation_enabled = true
bitmap_merge_area_size = 1048576
create_bitmap_area_size = 8388608

The bitmap_merge_area_size and create_bitmap_area_size parameters should be set to 
their default values. The ranges of these values are operating system dependent.

Administrative Client
The following software must be installed on the Administrative Client.

■ Oracle 9.2.x Warehouse Builder Client with Common Warehouse Metadata 
Transfer Wizard

■ Oracle Discoverer 4i Administration Edition Client (version 4.1.48)

■ Oracle Discoverer 4i User Edition Client (version 4.1.48)
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Tablespace Prerequisites
The tablespace requirements for EDW databases are listed below. Database 
tablespaces must be created in the source systems and in the warehouse system. 
The OWB repository tablespace must be created on the warehouse system only.

OWB Repository Tablespace
Before you install EDW Oracle Warehouse Builder metadata and generate the EDW  
EUL, you must create a tablespace for your EDW metadata in the warehouse. This 
document refers to the USER_DATA tablespace as the default tablespace for the 
EDW Oracle Warehouse Builder repository schema and EDW EUL.

■ EDWREPD - default data and snapshots tablespace. The tablespace size should 
be at least 600 MB.

■ EDWREPX - default index tablespace. The tablespace size should be at least 400 
MB.

Rollback Tablespace
Before you install EDW Oracle Warehouse Builder metadata and then generate the 
EDW EUL, make sure you allocate enough extents to the rollback segments and you 
have at least 400Mb of free space in rollback segments tablespace.

Set Up Database Links
The EDW Source patchset (11i.EWS.D), creates the following default database links 
on the source system: 

■ EDW_APPS_TO_WH 

■ APPS_TO_APPS 

Note: It is highly recommended to use separate Windows 
NT/2000/XP machines to install Oracle 9i Warehouse Builder 
Client software and Oracle Discoverer 4i Clients. In all cases 
Windows NT/2000/XP boxes with either OWB or Discoverer 
software installed will be referred as Administrative Client 
throughout this document.
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The EDW Warehouse patchset (11i.EDW.D), creates the following default database 
links on the warehouse system: 

■ EDW_APPS_TO_WH 

■ APPS_TO_APPS 

If both Source and Warehouse components of EDW share single instance of Oracle 
Applications 11i then the same pair of default database links will be present in 
Apps schema. 

These default generic database links must be set up properly as described below.  

Set Up Links from Warehouse to Source Systems
You must set up a dedicated link from warehouse to each of source systems. These 
links are used to pass configuration information from the warehouse to the source 
systems. 

Do not drop or modify the default generic database links created by 11i.EDW.D 
(EDW_APPS_TO_WH and APPS_TO_APPS). Those links are essential for proper 
functioning of EDW warehouse component. 

To set up database links from warehouse to source systems: 

1. Sign on to the warehouse database instance as APPS user using SQL*Plus. For 
instance: 

>sqlplus apps/<apps_passwd>@tst115

2. Create a database link EDW_WH_TO_<SOURCE_NAME> from the warehouse 
to each source system using the following syntax: 

>create database link <linkname> connect to <Oracle_Applications_Schema>

identified by <password> using '<connect_string>'; 

The following example illustrates how to create links from the warehouse to 
two sources: edw110s and edw107s: 

Attention: Customers, who implement both Source and 
Warehouse components on the single instance of Oracle 
Applications 11i, please skip the "Set Up Links from Warehouse to 
Source Systems" and "Set Up Links from Source Systems to 
Warehouse" sections and go directly to "Set Up Database Links for 
Single Instance EDW". 
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>create database link EDW_WH_TO_EDW110S connect to apps identified by apps 
using 'edw110s'; 

 >create database link EDW_WH_TO_EDW107S connect to apps identified by apps 
using 'edw107s';

3. Repeat the previous steps for each source system that you want to link to the 
warehouse. 

Set Up Links from Source Systems to Warehouse
Once you set up database links from your warehouse to your source system(s), you 
must also set up links from the source system(s) to the warehouse. 

To set up the source database links, first drop generic EDW_APPS_TO_WH link 
and then recreate it. You must not change the APPS_TO_APPS database link. 

To set up links from source system(s) to warehouse: 

1. Sign on to the soure database as APPS user using SQL*Plus. For example: 

>sqlplus apps/<apps_passwd>@edw110s;

2. Drop the generic database link EDW_APPS_TO_WH that was delivered with 
the source EDW patchset, 11i.EWS.C using the following syntax. 

>drop database link EDW_APPS_TO_WH;

3. Create the database link from the source system to the warehouse system using 
the following syntax: 

>create database link EDW_APPS_TO_WH connect to <Oracle_Applications_Schema> 
identified by <password> using '<connect_string>'; 

The following example illustrates how to connect the source system to the 
warehouse named tst115: 

>create database link EDW_APPS_TO_WH connect to apps identified by apps 
using 'tst115';

4. Repeat the previous steps for each source system. 

Set Up Database Links for Single Instance EDW
To set up database links correctly for single instance EDW, use a sequential 
approach. First, consider your instance to be warehouse system. Assume that you 
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must create an EDW_APPS_TO_<SOURCE> database link, where SOURCE is the 
same system. Second, consider your system to be the source and replace the generic 
link (EDW_APPS_TO_WH) with the link that points to the same system. 

To set up links on the single instance EDW: 

1. Sign on to the database as APPS user using SQL*Plus. For example: 

>sqlplus apps/<apps_passwd>@tst115

2. Create a database link EDW_WH_TO_<SELF> from the warehouse to each 
source system using the following syntax:

>create database link EDW_WH_TO<SELF> connect to apps identified by apps 
using '<connect_string>';

The following example illustrates how to create link from the warehouse to the 
source located at the same Oracle Applications instance:

>create database link EDW_WH_TO_TST115 connect to apps identified by apps 
using 'tst115';

3. Repeat step 2 for each standalone source system you want to link to the 
warehouse. 

4. Drop the generic database link EDW_APPS_TO_WH using the following 
syntax: 

>drop database link  EDW_APPS_TO_WH;

5. Create database link EDW_APPS_TO_WH which connects to the same instance 
of Oracle Applications using APPS schema using the following syntax: 

>create database link EDW_APPS_TO_WH connect to <Oracle_Applications_Schema> 
identified by <password> using '<connect_string>';

For example: 

>create database link EDW_APPS_TO_WH connect to apps identified by apps 
using 'tst115';
Installation Tasks 2-9



Install Oracle Warehouse Builder 9i and Repository
Install Oracle Warehouse Builder 9i and Repository
To install Oracle Warehouse Builder 9i and the Oracle Warehouse Builder 
repository, complete the following steps:

■ Install Oracle Data Warehouse Builder 9i on page 2-10

■ Install OWB Repository on page 2-11

Install Oracle Data Warehouse Builder 9i
Use the following steps to install Oracle Data Warehouse Builder 9i.

1. Obtain Oracle 9i Warehouse Builder 9.2.0.2.8 CD. This CD is included in the 
Oracle Applications Release 11i( 11.5.10) CD Pack

2. Install Oracle9i Warehouse Builder Client on the OWB Administrative Client. 
For more information on how to install the OWB client, see the Oracle 9i 
Warehouse Builder Installation Guide Release 9.2.0.2.8.

3. Apply the mandatory OWB9i Client patch 3455473.

a. Download the patch 3455473 from Oracle Metalink into a temporary 
directory on your Windows OWB Administrative Client machine.

b. Follow the instructions in the readme.txt file located in the uncompressed 
patch directory to apply the patch to your OWB9i Client.

4. After completing the OWB client install, execute the EDW_Config.bat script 
located in <OWB9i Home>\owb\bin\win32 on the OWB Administrative 
Client machine. This script requires the command line argument  <OWB9i 
Home> :

<drive>:\ <OWB9i Home>\owb\bin\win32\EDW_Config.bat  <OWB9i Home> 

For example: 

D:\> d:\OWB9.2\owb\bin\win32\EDW_Config.bat D:\OWB9.2

Note: The OWB Administrative Client machine must have at least 
512 MB of RAM and 1 Gigabyte of virtual memory. 400 MB of disk 
space must be allocated for the EDW EUL EEX file. For detailed 
hardware requirements, see: Hardware Prerequisites on page 2-4.
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Install OWB Repository 
The OWB Repository enables you to manage EDW metadata on the warehouse. 
You must install the OWB Repository on the database.  

The steps below briefly describe how to install OWB9i repository: 

To install OWB Repository:
1. On the OWB Administrative Client machine, start the Oracle Warehouse 

Builder Repository Assistant from the Oracle Warehouse Builder program 
group. The Welcome window appears. 

Figure 2–1 Welcome window

2. Click Next. The Server and SYSDBA Information window appears.
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Figure 2–2 Server and SYSDBA window

3. Click Next. The Create or Drop window appears.
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Figure 2–3 Create or Drop window

4. Choose the Create a new Warehouse Builder Repository option and click Next. 
The New or Existing Schema window appears.
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Figure 2–4 New or Existing Schema window

5. Choose the “Create and install into new user schema” option and click Next. 
The Username and Password (New) window appears. 
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Figure 2–5 User Name and Password (New) window

6. Enter the following information:

User Name: edwrep 

Password: <edwrep user password>

Click Next. The Tablespace window appears.
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Figure 2–6 Tablespace window

7. Chose the default data tablespace for EDWREP database schema from the 
"Select the tablespace for data" list of values.

8. Chose the default index tablespace for EDWREP database schema from the 
"Select the tablespace for indexes" list of values.

9. Chose the temporary tablespace for EDWREP database schema from the "Select 
the tablespace for temporary data" list of values.

10. Chose the default tablespace for snapshots for EDWREP database schema from 
the "Select the tablespace for snapshots" list of values. Click the Next button to 
continue. The Define Languages window appears.
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Figure 2–7 Define Languages window

11. Choose "American English" from the "Choose MLS base language" list of 
values. Click Next to continue. The Summary window appears.
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Figure 2–8 Summary window

12. The Summary window contains a list of all the selections you have made. 
Verify that the OWB repository setup information is correct.

a. If the setup information is incorrect, click the Back button until you reach 
the appropriate screen and re-enter the correct values. Click the Next 
button repeatedly until you return to the Summary window.

b. If the set up information is correct, choose the Finish button. The Embedded 
Data Warehouse schema is created and installed in your warehouse.
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13. Apply patch 3295986 to populate the EDW Repository.

Apply patch 3295986 to the warehouse. The estimated time for running the 
patch is one hour. Use AutoPatch to apply the patch drivers in the following 
order (if they exist):

■ c3295986.drv (on all servers)

■ d3295986.drv (on administration server only)

■ g3295986.drv (on all servers)

Important:  OWB9i Repository schema EDWREP is registered in 
this release as an External schema for Oracle Applications.

Execute the FNDCPASS command on the administration tier to 
propagate the EDWREP password into the Warehouse instance. 
The password must be the same as EDWREP password used 
during OWB Repository creation (step 7 on page 2-16):

■ $ FNDCPASS apps/<apps password> 0 Y system/<system 
password> ORACLE edwrep <edwrep password>

For example:

■ $ FNDCPASS apps/apps 0 Y system/manager ORACLE 
edwrep edwrep

Make sure you have at least 600 MB of free space in the data 
tablespace of BIS schema.
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Check Validation Point
At this point, you should contact your implementation team.

Verify whether the implementation team is planning to perform any of the 
following optional implementation tasks at this validation point:

■ Mapping flexfields (Accounting, Key, Descriptive)

■ Mapping user-defined attribute

■ Modifying EDW metadata

If the implementation team is planning to perform any of these tasks, stop and 
complete these tasks before proceeding. 

For more information on how to implement EDW, see the Oracle Embedded Data 
Warehouse Implementation Guide.
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Create the EDW EUL and Import EDW Workbooks
Once you have set up the warehouse, you must install the EUL and workbooks. 
Complete the EUL and workbook installation steps in the following order.

1. Create the EUL on page 2-21

2. Generate the EDW EUL EEX File on page 2-22

3. Import the EDW EUL EEX File on page 2-25

Create the EUL
The first step in installing the EUL and workbooks is to create an applications-mode 
EUL that supports specific Oracle Applications functionality. This functionality is 
required to run EDW.

To create the EUL:

1. Create a separate tablespace for the EDW EUL database schema. Ensure that the 
storage parameter MAX_EXTENTS is at least 150.

2. On the Discoverer4i Administrative Client machine, open an MS-DOS 
command prompt window and run the following command: 

dis4adm.exe  /CREATE_EUL  /APPS_MODE  /CONNECT system/<system 
password>@<database>  /USER  EDWEUL_US  /PASSWORD <edweul_us password>  
/DEFAULT_TABLESPACE  <edweul_us user default tablespace> /TEMPORARY_
TABLESPACE  <temporary tablespace>  /SET_EUL_LANGUAGE <Language code>
/APPS_GRANT_DETAILS  apps/<apps password>   /SHOW_PROGRESS 

Note: Before creating the EUL you should identify the default 
tablespace for the EUL owner. Ensure that you have this tablespace 
available on the warehouse before you proceed. This document 
refers to the USER_DATA tablespace as the default tablespace for 
the EUL database schema in the examples. 

Note: Before performing steps in this section, please verify that 
Discoverer 4i Administration Edition is installed on a Windows 
NT/2000/XP PC. This PC will be referred to hereafter as the 
Discoverer4i Administrative Client machine. 
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For example: 

dis4adm.exe  /CREATE_EUL  /APPS_MODE  /CONNECT system/manager@tst115  /USER  
EDWEUL_US  /PASSWORD edweul  /DEFAULT_TABLESPACE  user_data  /TEMPORARY_
TABLESPACE  temp /SET_EUL_LANGUAGE US /APPS_GRANT_DETAILS  apps/apps   
/SHOW_PROGRESS 

A window showing the EUL installation progress appears in a couple of seconds. 
Wait until the EUL installation is over before proceeding with the installation.

Generate the EDW EUL EEX File
Generate the EDW EUL EEX file using the CWM transfer wizard on the OWB 
Administrative Client machine. This wizard generates an ASCII export file based on 
user-defined flexfields, attribute mappings, and Applications Integrator set-ups. 
You will later import this file into the database tier of the warehouse.

To generate the EEX file:
1. Log on to the OWB Administrative Client machine and run OWB as an owner 

of the EDW OWB repository schema. For example, 
EDWREP/EDWREP@TST115. 

2. Select the project "EDWPRJ". 

3. Choose the OK button.

Note: The OWB Administrative Client machine must have at least 
512 MB of RAM and 1 Gigabyte of virtual memory. 400 MB of disk 
space must be allocated for the EDW EUL EEX file. For detailed 
hardware requirements, see: Hardware Prerequisites on page 2-4.
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Figure 2–9 Oracle Warehouse Builder: Metadata Export Window

4. From the Projects menu, choose Metadata Export > Bridge. The CWM Transfer 
Wizard appears.

Configure the wizard to generate the EDW EUL. When using the wizard, 
ensure that "Oracle Discoverer" is the selected target product on "Metadata 
Source and Target Identification" window and that the following values are 
provided for the "CWM Transfer Parameters" window.
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Figure 2–10 CWM Transfer Parameters Window

Once you have verified the preceding parameter values, you have generated the 
EDW EUL and you can proceed with the EUL import.

Table 2–2 CWM Transfer Parameters

Transfer Parameter Value

OWB Exported Collections All Collections

OWB Translated Language American English

Discoverer EUL Owner EDWEUL_US

Discoverer Schema Owner APPS

Dimensional Reuse True

Discoverer Output File edweul.exe

Log Level Information
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Import the EDW EUL EEX File
After you have generated the EEX file, you can use the Oracle Discoverer 4i 
Administration Edition client to import the EEX file into the warehouse system 
database.

To import the EEX file:
1. Copy the edweul.eex file to the Discoverer4i Administration Client machine.

2. Run Discoverer Administration Client and connect as the EUL owner. For 
example, EDWEUL_US.

3. Choose Import from the File menu.

4. Choose edweul.eex from the list of values and choose Add. 

5. Ensure that you select the following import options:

■ Refresh the object

■ By Identifier

■ Always take ownership of imported workbooks

Additional Information: See the Oracle Discoverer 4i Administration 
Guide for more information on how to import the EEX file.
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Figure 2–11 Oracle Discoverer 4i EUL Import Options

6. Choose Start. The import process begins.

7. After the import is over, click the Finish button and wait until SQL regeneration 
is done.
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Configure Security
To configure security using Oracle Discoverer 4i, complete these steps in the 
following order.

1. Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or 
Administration Client on page 2-28

2. Grant Users/Responsibilities Access to Business Areas on page 2-29

3. Transfer EDW Discoverer 4i Contents to Windows NT/2000/XP Client on 
page 2-30

4. Define Default Profile Options on page 2-32
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Grant Users/Responsibilities Access to Oracle Discoverer 4i User,
 or Administration Client

Grant users and responsibilities access to Oracle Discoverer 4i Plus. Limit the 
number of users who are granted access to Oracle Discoverer 4i Administration 
Edition client.   

To grant access to Oracle Discoverer 4i Plus or Administration Client:
1. Log in to the Oracle Discoverer 4i Administration Client machine and run the 

Oracle Discoverer 4i Administration Edition client. 

2. Connect to the database as the edweul owner (EDWEUL_US), for example:

edweul_us/edweul@database 

3. Check the default EUL by doing the following:

a. Set the default EUL by choosing Select Tools > Options > Default EUL.

b. Set the default to EDW EUL owner. For example, EDWEUL_US.

4. Grant the user or responsibility access to Oracle Discoverer 4i Plus or 
Administration Client by doing the following:

a. Choose Tools > Privileges.

b. Select the responsibility. For example, "Sysadmin - System Administrator".

c. Give the responsibility access to either the 4i Plus or Administration Edition 
(or both, if necessary) by selecting the appropriate checkboxes.

d. Repeat steps a to c for each of the following responsibilities:

■ Financial Intelligence - Enterprise DataWarehouse 

■ Manufacturing Intelligence  - Enterprise DataWarehouse 

■ Purchasing Intelligence - Enterprise DataWarehouse 

■ Supply Chain Intelligence - Enterprise DataWarehouse 

■ Human Resources Intelligence - Enterprise DataWarehouse 

Important: Throughout this section, be sure you are using the 
EDW EUL (edweul_us) user.
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Grant Users/Responsibilities Access to Business Areas
Once you grant the users/responsibilities access to Oracle Discoverer 4i, you must 
grant them access to the applicable business areas. You can also create new 
responsibilities if the ones provided do not meet your needs.

To grant users/responsibilities access to Business Areas:

1. In Oracle Discoverer 4i Administration Edition client, choose Tools -> Secutiry.

2. Select the responsibility.

3. Grant the responsibility access to the business areas, as shown in the table 
above.

Table 2–3 Responsibilities and Business Areas 

Responsibility  Business Area  Has Access To…

Financials Intelligence - 
Enterprise Data 
Warehouse

EDW_COMMON_MODULE_ 
Payables Intelligence business area

 Access to Business Intelligence System 
Payables Business Area and 
Workbooks

Financials Intelligence - 
Enterprise Data 
Warehouse

 EDW_COMMON_MODULE_
Revenue Intelligence business area

 Access to Business Intelligence System 
Receivables Business Area and 
Workbooks

Financials Intelligence - 
Enterprise Data 
Warehouse

 EDW_COMMON_MODULE_Project 
Intelligence business area

 Access to Business Intelligence 
Projects Business Area and Workbooks

Human Resources 
Intelligence - Enterprise 
Data Warehouse

 EDW_COMMON_MODULE_Human 
Resource Intelligence - Workforce 
Planning business area

 Access to Business Intelligence 
Workforce Planning Business Area 
and Workbooks

Manufacturing 
Intelligence - Enterprise 
Data Warehouse

EDW_COMMON_MODULE_ 
Manufacturing Intelligence business 
area

 Access to Business Intelligence System 
Manufacturing Business Area and 
Workbooks

Manufacturing 
Intelligence - Enterprise 
Data Warehouse

EDW_COMMON_MODULE_ 
Operations Intelligence business area

 Access to Business Intelligence System 
Operations Business Area and 
Workbooks

Purchasing Intelligence - 
Enterprise Data 
Warehouse

EDW_COMMON_MODULE_ 
Purchasing Intelligence business area

 Access to Business Intelligence System 
Purchasing Business Area and 
Workbooks

Supply Chain Intelligence 
- Enterprise Data 
Warehouse

EDW_COMMON_MODULE_ Supply 
Chain Intelligence business area

 Access to Business Intelligence System 
Supply Chain Business Area and 
Workbooks
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4. If the responsibility needs adminitrative access to the business area, enable the 
Allow Administration checkbox.

5. Connect to Discoverer 4i Administration Edition as a valid Applications user 
with a valid responsibility (for example, "SYSADMIN:System Administrator"), 
which has been granted access to Discoverer 4i Administration Client (see: 
Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or 
Administration Client on page 2-28) and validate your folders by choosing 
Choose View -> Validate Folders.

For more information on how to grant access and define EUL security, see the 
Oracle Discoverer 4i Administration Guide.

Transfer EDW Discoverer 4i Contents to Windows NT/2000/XP Client
Discoverer 4i EUL contents and workbooks are delivered as EEX files that are 
staged by AutoPatch in the $/AU_TOP/discover/<LANG> directory. It requires 
MKS Toolkit installed on the Discoverer 4i Administration Client machine.

Important: The Process Manufacturing Intelligence Business Area 
has been obsolete. Please do not refresh the Business Area, do not 
validate and do not use the contents of the following folders for 
building custom workbooks:

■ Formula Dimension

■ Grade Dimension

■ PMI Batch Detail Fact

■ PMI Batch Grade Fact

■ PMI Batch Quality Fact

■ PMI Batch Resource Fact

■ PMI Margin

■ QC Assay Dimension

■ Routing Dimension

You may safely ignore any warnings/errors you can get for these 
folders.
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To transfer EDW Discoverer 4i contents:
1. Choose one of the following methods to get access to Discoverer 4i EEX files:

■ Map your Oracle Applications AU_TOP to your Discoverer 4i 
Administration Client machine as a network drive and execute the 
adupdeul.sh script from the \discover directory on the mapped network 
drive.

■ Transfer $AU_TOP/discover directory and its contents (including 
subdirectories) to a temporary directory on your Discoverer 4i 
Administration Client machine and execute the adupdeul.sh script from the 
temporary directory.

2. Load the EDW 4.2 Discoverer 4i contents into the EDW EUL by doing the 
following:

a. Open an MS-DOS command prompt window.

b. Change to the mounted directory / temporary directory where the 
$AU_TOP/discover directory contents are located.

3. Import EDW 4.2 Discoverer 4i workbooks and extended EUL contents by 
executing the following command:

> sh adupdeul.sh connect="<APPS User>:<Valid Apps responsibility 
name>"/<Apps user password>@<two_task> resp=<APPS responsibility name> 
gwyuid=applsyspbub/pub fndnam=apps secgroup="Standard" topdir=<top level 
directory where discoverer files are available> language=<comma separated 
list of language codes> eulprefix=<EUL prefix (for ex: EDWEUL)> eultype=EDW 
mode=driver exedir=<directory where discoverer executables are located> 
driver=c3295042.drv logfile=adupdeul.log

For example:

Important: Ensure that the MKS Toolkit is installed on the 
Discoverer 4i Administration Client machine.

Important: If you install EDW 4.2 as part of Oracle Applications 
Release 11i.10, execute the adupdeul.sh script in mode=complete. In 
this mode you should omit option driver=u.3295042.drv.
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d:\temp> sh adupdeul.sh connect="sysadmin:System 
Administrator/sysadmin@apps115 resp="System Administrator" 
gwyuid=applsyspub/pub fndnam=apps secgroup="Standard" topdir=d:/temp 
language=us eulprefix=EDWEUL eultype=EDW mode=driver exedir=d:/orant/discvr4 
driver=c3295042.drv logfile=d:/temp/adupdeul.log

4. Check adupdeul.log file for any errors. 

Define Default Profile Options
After you have granted your users/responsibilities access to the workbooks, you 
must define default profile options.

To define default profile options:

1. Connect to your warehouse Oracle Applications with ‘System Administrator’ 
responsibility:

a. Navigate to Profile > System.

b. Choose the Responsibility button and select the Global Warehouse 
Administrator responsibility.

c. Run query for Profile ICX:%.

2. For the ICX: Discoverer Default End User Layer Schema Prefix profile option, 
enter edweul at the responsibility level. Do not overwrite the EUL definition at 
the site level.

3. For the ICX: Discoverer EDW End User Layer Schema Prefix profile option, 
enter edweul at the responsibility level. Do not overwrite the EUL definition at 
the site level.

4. Perform steps 1 to 3 for each of the responsibilities below:

■ Financial Intelligence - Enterprise Data Warehouse

■ Manufacturing Intelligence - Enterprise Data Warehouse

■ Purchasing Intelligence - Enterprise Data Warehouse

■ Supply Chain Intelligence - Enterprise Data Warehouse

■ Human Resource Intelligence - Enterprise Data Warehouse

Backup Source Systems and Warehouse
Congratulations! You have successfully completed installing EDW. 
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Once you complete the installation, it is highly recommended that you backup the 
data on both your source and warehouse systems to ensure that you can always 
return to this fresh-install state. This step is optional.
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3

Upgrade Tasks

This chapter describes how to upgrade and configure Oracle E-Business Intelligence 
Embedded Data Warehouse (EDW). This chapter covers the following topics.

■ Overview of Upgrading EDW on page 3-2

■ Back Up Source Systems and Warehouse on page 3-2

■ Verify Prerequisites on page 3-3

■ Upgrade Oracle Warehouse Builder Repository on page 3-5

■ Upgrade Embedded Data Warehouse End User Layer (EUL) on page 3-18

■ Configure Security on page 3-22

■ Create OWB 9.2 Metadata Repository on page 3-22
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Overview of Upgrading EDW
This chapter describes how to upgrade EDW from a previous release of EDW to 
release 4.2. 

To avoid unexpected delays in the upgrade, please read through this entire section 
and familiarize yourself with the upgrade process before you begin. 

The following table contains a checklist that you can use when upgrading EDW.

Back Up Source Systems and Warehouse
Before you begin your upgrade of EDW, ensure that you back up your source and 
warehouse instances. 

This back up step is optional, but it ensures that you can always return to your 
previous system state. 

Important: It is highly recommended that this upgrade be 
performed by an Oracle Applications database administrator in 
cooperation with the implementation team.

Table 3–1 Upgrade Steps

Step Location Task List

Back Up Source Systems 
and Warehouse on page 3-2

Source Systems

Warehouse 
System

■ Back Up Source Systems and 
Warehouse

Verify Prerequisites  on 
page 3-3

Source Systems

Warehouse 
System

Administration 
Client machines

■ Hardware Prerequisites

■ Software Prerequisites

Upgrade Oracle Warehouse 
Builder Repository on 
page 3-5

OWB 9i 
Administration 
Client machine

Warehouse 
System

■ Install Oracle Warehouse Builder 
9.2.0.4

■ Upgrade OWB Repository from 9i 
(9.0.3) to 9i Release 2
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Verify Prerequisites
Before you begin to upgrade EDW, you must verify that all hardware and software 
prerequisites have been met.

This section contains the following topics.

■ Hardware Prerequisites

■ Software Prerequisites

 Hardware Prerequisites
To successfully complete the install, you must have the following hardware 
available.

Source Systems
For information on hardware requirements for your 11i source systems, see the 
installation documentation for the respective system.

Warehouse
For the hardware requirements for the database, see Oracle 8i(9i) Installation Guide. 

For the hardware requirements and supported platforms for Oracle Discoverer, see 
Oracle Discoverer 4i Installation Guide or Oracle Discoverer 10g Installation Guide. 

Administrative Client
The Oracle Warehouse Builder Client requires one of the following Windows 
operating systems:

■ Microsoft Windows NT 4.0 with Service Pack 6 or higher

■ Microsoft Windows 2000

■ Microsoft Windows XP Professional Edition

The Windows NT/2000/XP server should have at least 1 GB of RAM and 2 GB of 
space for installing the OWB Client and converting the OWB metadata repository. 
The Warehouse Builder Client 9.2 required Oracle 8.1.7 or Oracle 9i Database Server 
Release 1 or 2.

See: Oracle 9i Warehouse Builder Installation and Configuration Guide Release 9.2.
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 Software Prerequisites
To successfully complete the install, you must have the following software available 
on the source system and warehouse servers.

Source Systems
You must have one or more of the following standard source systems. For 
information on the standard install for each source system, see the appropriate 
installation documentation.

■ Oracle Applications Release 11i with patchset 3 or higher

You must also have the EDW Release 4.2 mini-pack, with the source patchset 
(11i.EWS.D) installed on each source system. For more information see About Oracle 
Embedded Data Warehouse Release 4.2 on MetaLink.

Warehouse
You must have the following standard warehouse system. For information on the 
install for the warehouse system, see the appropriate installation documentation.

■ Oracle Applications Release 11i with patch set 3 or higher

You must also have the EDW Release 4.2 mini-pack, with the warehouse patchset 
(11i.EDW.D) installed on the warehouse system. For more information see About 
Oracle Embedded Data Warehouse for Release 4.2 on MetaLink.

For RDBMS 8i only, update your init.ora parameter file with the following 
initialization parameters:

star_transformation_enabled = true
bitmap_merge_area_size = 1048576
create_bitmap_area_size = 8388608

The bitmap_merge_area_size and create_bitmap_area_size parameters should be set to 
their default values. The ranges of these values are operating system dependent.

Administrative Client
The following software must be installed on the Administrative Client.

■ Oracle 9i Warehouse Builder Client with Common Warehouse Metadata 
Transfer Wizard

■ Oracle Discoverer 4i Administration Edition Client (version 4.1.48)
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■ Oracle Discoverer 4i User Edition Client (version 4.1.48) 

Upgrade Oracle Warehouse Builder Repository

If you are upgrading from a version of EDW with OWB 2.1.1, see: Migrate OWB 
Repository from 2.1.1 to 9i Release 2 on page 3-6

If you are upgrading from EDW Release 4.0 or higher, with OWB 9i, see: Upgrade 
OWB Repository from 9i (9.0.3) to 9i Release 2 on page 3-11

Install Oracle Warehouse Builder 9.2.0.4
To install Oracle Warehouse Builder 9.2:

1. Obtain the Oracle 9i Warehouse Builder 9.2.0.8 CD (Part Number B11781-01).

2. Install Oracle 9i Warehouse Builder Client on the OWB Administrative Client. 
For information on how to install the OWB client, see: Oracle 9i Warehouse 
Builder Installation and Configuration Guide Release 9.2.

3. Apply the mandatory OWB9.2 Client patch 3455473.

a. Download patch 3455473 from Metalink into a temporary directory on your 
Windows OWB Administrative Client machine.

Note: It is highly recommended to use separate Windows 
machines to install Oracle 9i Warehouse Builder Client software 
and Oracle Discoverer 4i Clients. In all cases Windows machines 
with either OWB or Discoverer software installed will be referred 
as Administrative Client throughout this document.

Important: EDW Release 4.2 is certified with OWB Repository 9i 
Release 2 only. 

Note: The OWB Administrative Client machine must have at least 
1 GB of RAM and 2 GB of virtual memory. Allocate 400 MB of 
diskspace for the EDW EUL EEX file. For detailed hardware 
requirements, see: Hardware Prerequisites on page 3-3.
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b. Follow the instructions in the readme.txt file located in the uncompressed 
patch directory to apply the patch to your OWB9.2 Client.

4. After completing the OWB client install, execute teh EDW_Config.bat script 
located in <OWB9.2 Home>\owb\bin\win32 on the OWB Administrative 
Client machine. This script requires the command line argument <OWB9.2 
Home>:

<Drive>:\<OWB9.2 Home>\owb\bin\win32\EDW_Config.bat <OWB9.2 Home>

For example:

D:\>d:\OWB92\owb\bin\win32\EDW_Config.bat D:\OWB92

Migrate OWB Repository from 2.1.1 to 9i Release 2
Perform this step only if you are upgrading from EDW Release 3.1, 3.2, or 4.0 with 
OWB Repository 2.1.1. You do not need to perform this step if you already use 
OWB Repository 9i (9.0.3).

1. Backup your current OWB 2.1.1 Repository schema. Use the standard Oracle 
export utility located on the Database Tier.

For example:

exp system/manager@tst115 owner=edwrep buffer=2000000 
file=edwrep_owb211.dmp log=edwrep_owb211_exp.log

2. Backup the EDW security metadata tables using the standard Oracle export 
utility located on the Database Tier.

For example:

exp system/manager@tst115 tables=(BIS.EDW_SEC_DIM_INFO_T, 
BIS.EDW_SEC_LVL_INFO_T, BIS.ED_SEC_FACT_INFO_T, 

Additional Information: For more information on how to install 
the OWB client and repository, see: Oracle Warehouse Builder 
Installation Guide Release 9i.

Additional Information:  For more information on how to use the 
export utility see: Oracle System Administrator's Guide.
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BIS.EDW_SEC_REF_INFO_T, BIS.EDW_SEC_DIM_ACCESS) rows=Y 
buffer=2000000 file=bis_sec211.dmp log=bis_sec211.log

3. Upload the latest metadata into the current OWB 2.1.1 Repository schema. On 
the OWB Administrative Client machine, download patch 3566146 from 
Metalink into a temporary directory and uncompress the patch. Follow the 
instructions in the readme.txt file supplied with the patch, to upload metadata 
into OWB 2.1.1 Repository schema.

4. Convert the current OWB 2.1.1 Repository Metadata into OWB 9i Metadata 
format. 

a. Download the patch 2430213 from Metalink. Create the subdirectory 
’upgrade’ under <OWB9.2 Home>\owb directory and uncompresses the 
patch archive contents into ’upgrade’ subdirectory.

b. Open the command line window and change to the <OWB9.2 
Home>\owb\upgrade directory.

c. Execute the script make9i.bat with the argument ’-new parfile.txt’ to 
generate a template parameter file:

For example:

D:\>cd\OWB92\owb\upgrade
D:\OWB92\owb\upgrade\> make9i.bat -new parfile.txt

d. Open the generated parameter file parfile.txt and update it with your local 
settings. Refer to Table 3–2, "OWB 2.1.1 to 9i Conversion Parameters" for 
settings details.

Table 3–2 OWB 2.1.1 to 9i Conversion Parameters

Parameter 
Name Parameter Description Notes

username OWB Repository schema name: EDWREP The name EDWREP is mandatory 
and should not be changed

password OWB Repository schema password

host Name of the database server where OWB Repository 
database installed

sid OWB Repository database instance name

port TNS listener port number for OWB database instance
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The sample contents of the generated parfile.txt are below

No spaces after > please
username>edwrep
password>edwrep
host>ap301sun
sid>tst115
port>1527
tns alias>tst115
temp dir>d:\owb903\owb\upgrade
owb bin dir>d:\owb903\owb\bin\win32
211 bin dir>d:\owb21134\owb\wbapp

tns TNS alias of the OWB database instance Make sure you have the valid TNS 
entry in your TNSNAMES.ora file 
on the Windows NT/2000 OWB9i 
tier where you plan to convert the 
metadata.

tmp dir Full path of the directory where the batch scripts 
installed

<OWB92 HOME>\owb\upgrade

owb bin dir Full path of the directory where the migration utilities 
installed

<OWB92 HOME>\owb\bin\win32

211 bin dir Full path of OWB 2.1.1 metadata extraction utilities <OWB211>\owb\wbapp

Note: The generated 'parfile.txt' will contain the line "No spaces 
after > please ". This line does not affect the migration process and 
could be safely ignored or deleted from 'parfile.txt'.

Parameter 
Name Parameter Description Notes
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e. Modify the java virtual machine memory size parameter in the data 
conversion startup script. Open the file <OWB92 
HOME>\owb\bin\win32\mdlconvert.bat and set the parameter '-Xmx' to 
'800M' (i.e. '-Xmx800M').

f. Execute make9i.bat script with the argument ‘parfile.txt’. It will convert the 
repository metadata and extract it into the metadata files staged in the 
temporary directory defined in parfile.txt:

For example:

d:\OWB903\owb\upgrade\> make9i.bat parfile.txt > make9i.log

5. Drop the current OWB 2.1.1 Repository schema.

Connect to the database system account and drop the 2.1.1 Repository schema 
EDWREP: 

For example:

SQL> drop user edwrep cascade;

Note: Make sure you have Oracle SQL*PLUS installed on OWB9i 
Client server and you are able to connect successfully to Embedded 
Data Warehouse  Instance using SQL*PLUS.

Note: It takes approximately 4 hours to complete this step. The 
actual time may vary depending on processor speed and RAM 
available on your OWB9i tier. 

Note: Complete this step ONLY after you successfully completed 
all the steps listed above. 
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6. Create a new OWB9.2 Repository using Oracle9.2 Warehouse Builder 
Repository Assistant. 

See: Create OWB 9.2 Metadata Repository on page 3-22.

7. Import the converted metadata files into the newly created OWB9.2 Repository.

a. Execute the import script <OWB92 Home>\owb\upgrade\imp9i.bat with the 
argument ‘parfile.txt’.

For example:

D:\OWB903\owb\upgrade\> imp9i.bat parfile.txt > imp9i.log

8. Verify that you have successfully converted your 2.1.1 Repository to a OWB 9.2 
Repository.

9. Apply the interoperability patch 2360757 on the warehouse instance.

a. Back up the the OWB9i Repository:

For Example:

exp edwrep/edwrep@apps115 buffer=2000000 
file=/d2/stage/owb9i.dmp grants=N INDEXES=N 
CONSTRAINTS=N LOG=/d2/stage/owb9i_imp.log 
TABLES=CMPALLCLASSES,CMPALLFOLDERFCONAMES

b. Execute the FNDCPASS command on the administration tier to propagate 
the EDWREP password into the Warehouse instance. The password must 
be the same as EDWREP password used during OWB Repository creation 
(step g on page 3-16)::

FNDCPASS apps/<apps password> 0 Y system/<system password> ORACLE edwrep 
<edwrep password>

Note: Make sure you have at least 500 MB of free space available 
in Repository schema (EDWREP) default  tablespace and enough 
rollback tablespace space /rollback segments for the metadata 
import.

Important: The OWB9i Repository schema EDWREP is registered 
as an External schema for Oracle Applications in EDW 4.2.
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For Example:

FNDCPASS apps/apps 0 Y system/manager ORACLE edwrep edwrep

c. Apply patch 2360757 to your warehouse instance.

Use AutoPatch to apply the patch drivers in the following order (if they 
exist):

– c2360757.drv (on all servers)

– d2360757.drv (on administration server only)

– g2360757.drv (on all servers)

10. Download patch 3566149 from OracleMetaLink on to the OWB Administrative 
client machine. Uncompress the patch into a temporary directory and follow 
the instructions in the readme.txt file to apply the patch to OWB 9.2 metadata 
repository.

11. Download patch 3566152 from OracleMetaLink on to the OWB Administrative 
Client machine. Uncompress the patch into a temporary directory and follow 
the instructions in the readme.txt file to apply the patch to OWB 9.2 metadata 
repository.

12. Refresh EDW OWB 9.2 metadata table layer by doing the following:

a. Log into Oracle Applications Warehouse and select "Global Warehouse 
Administrator" responsibility.

b. Navigate to Requests => Submit New Request => Refresh EDW metadata.

c. Choose the Submit button.

Your OWB Metadata Repository migration is complete. Proceed to Create the EDW 
EUL and Import EDW Workbooks on page 2-21.

Upgrade OWB Repository from 9i (9.0.3) to 9i Release 2
Perform this step only if you are upgrading from EDW Release 4.0 or higher with 
OWB Repository 9i (9.0.3). You do not need to perform this step if you already use 
OWB Repository 9i (9.0.3). Skip this step if you migrated OWB Repository from 
2.1.1 to 9.2.
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To upgrade the OWB 9i Repository, do the following: 

1. Backup the OWB 9.0.3 Repository

For example:

exp edwrep/edwrep@apps115 buffer=2000000
file=/d2/stage/owb903.dmp grants=N INDEXES=N CONSTRAINTS=N
LOG=/d2/stage/owb903_imp.log TABLES=CMOALLFOLDERCONAMES

2. Apply patch 2992954 to your warehouse instance.

Use AutoPatch to apply the patch drivers in the following order (if they exist):

– c2992954.drv (on all servers)

– d2992954.drv (on administration server only)

– g2992954.drv (on all servers)

3. You only need to perform this step if you are upgrading from EDW Release 4.0 
with OWB Repository 9.0.3. Skip this step if you are upgrading from EDW 4.1.

Download patch 3566149 from OracleMetaLink on to the OWB Administrative 
Client machine. Uncompress the patch into a separate temporary directory and 
follow the instructions in the readme.txt file to apply the patch to OWB 9.2 
metadata repository.

4. Download patch 3566152 from OracleMetaLink on to the OWB Administrative 
Client machine. Uncompress the patch into a separate temporary directory and 
follow the instructions in the readme.txt file to apply the patch to OWB 9.2 
metadata repository.

5. Export OWB 9.0.3 Metadata into file.

a. Start OWB 9.0.3 on the Administrative Client. The Warehouse Builder 
Logon window appears.
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Figure 3–1 Warehouse Builder Logon window

b. Enter the OWB Repository schema password and choose Connection Info . . 
. button. The Connect Information window appears.

Figure 3–2 Connect Information window

c. Enter host name, database listener port and Oracle SID of the Warehouse 
system. Click OK to go back to the Logon window and click Logon. The 
Select a project to open window appears.
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Figure 3–3 Select a Project

d. Select the EDWPRJ project from the list of available projects and click OK. 
The EDWPRJ project window appears.

Figure 3–4 EDWPRJ project window

e. In top menu item Project, select MetaData Export -> File. The Metadata 
Export Window appears.
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Figure 3–5 Metadata Export Window

f. Provide full name of the file where exported metadata will be stored, and 
location of a log file. Choose Export button. After export finishes check log 
file for error messages.

6. Drop the current OWB 9.0.3 Repository schema.

Important: Complete step 6 only after you successfully completed 
all the steps listed above
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Connect to the database system account and drop the 9.03 Repository schema 
EDWREP.

For example:

SQL> drop user edwrep cascade;

7. Create new OWB9i Repository using Oracle 9.2 Warehouse Builder Repository.

See: Create OWB 9.2 Metadata Repository on page 3-22.

8. Import extracted OWB 9.0.3 metadata into the new OWB 9.2 Repository.

a. Start the OWB 9.2 Administrative Client. The Warehouse Builder Logon 
window appears.

b. Enter OWB Repository schema password and choose Connection Info . . . . 
The Connect Information window appears.

c. Enter the host name, database listener port, and Oracle SID of the 
Warehouse system. Choose OK to go back to the Logon Window and press 
Logon. List of available OWB projects will appear. Select EDWPRJ project 
from the list.

d. In top menu item Project, select MetaData Import -> File. The Metadata 
Import Utility Window appears.
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Figure 3–6 Metadata Import Utility Window 

e. Enter the name of the extracted OWB 9.0.3 metadata file. Ensure that the 
Import Option and Match By parameters are selected as shown. Choose 
Import. After the import is complete, check the log file for error messages.

9. Apply the interoperability patch 2360757 on the warehouse instance.

a. Back up the OWB 9.2 Repository 

For example:

exp  edwrep/edwrep@apps115 buffer=2000000
file=/d2/stage/owb92.dmp grants=N INDEXES=N
CONTRATINST=N LOG=/d2/stage/owb92_imp.log
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TABLES=CMPALLCLASSES, FCOFOLDERNAMESPACE

 

b. Execute the FNDCPASS command on the administration tier to propagate 
the EDWREP password into the Warehouse instance. The password must 
be the same as EDWREP password used during OWB Repository creation.

FNDCPASS apps/<apps password> 0 Y system/<system password> ORACLE 
edwrep<edwrep password>

For example:

FNDCPASS apps/apps 0 Y system/manager ORACLE edwrep edwrep

c. Apply patch 2360757 to your warehouse instance. Use AutoPatch to apply 
the patch drivers in the following order (if they exist):

– c2360757.drv (on all servers)

– d2360757.drv (on administation server only)

– g2360757.drv (on all servers)

10. Refresh EDW OWB 9.2 metadata table layer by doing the following:

a. Log into Oracle Applications Warehouse and select "Global Warehouse 
Administrator" responsibility.

b. Navigate to Requests => Submit New Request => Refresh EDW metadata. 
Choose the Submit button.

Your OWB Metadata Repository upgrade is complete. 

Upgrade Embedded Data Warehouse End User Layer (EUL)
If you are upgrading from EDW Release 3.x with OWB 2.1.1 or from EDW Release 
4.0 with OWB 2.1.1, you must first convert your EDW EUL and then upgrade your 
custom workbooks.

Important: The OWB9i Repository schema EDWREP is registered 
as an external schema for Oracle Applications in EDW 4.2.
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If you are upgrading from EDW Release 4.x with OWB 9i you must first upgrade 
your EDW EUL and then upgrade your custom workbooks.

Convert EDW EUL
Convert the EDW EUL only if you are upgrading from EDW Release 3.x with OWB 
2.1.1 or from EDW Release 4.0 with OWB 2.1.1.

1. Make sure you have at least 400 MB of temporary space and 600 MB of free disk 
space on both OWB9.2 and Discoverer 4i Administrative Client machines.

2. Create separate folder named 'upgrade', in <OWB9.2_HOME>\owb folder on 
the OWB9.2 Administrative Client.

3. Download patch 2430213 from OracleMetaLink and uncompress it into your 
<OWB9.2_HOME>\owb\upgrade folder on OWB9.2 Administrative Client.

4. Change your working directory to <OWB9.2_HOME>\owb\upgrade and 
update the generate_eex.bat and update_EUL.bat files where appropriate, with 
the actual values provided in the table below.

Important: If you created any custom workbooks make sure you 
preserve all the customizations before you proceed with EUL 
upgrade.

Table 3–3 Actual Values

Parameter Name Description Example

ORAINSTALL ORACLE_HOME directory on Discoverer 
4i Administrative Client machine

D:\orant

OWBINSTALL The folder where OWB9i software is 
installed (referred to as <OWB9.2_HOME> 
in this document)

 D:\OWB92

DISCO_ID Discoverer EUL schema name EDWEUL_US

DISCO_PASSWD Password of Discoverer EDW EUL schema edweul

SCHEMA_OWNER Database schema which owns the EDW 
Discoverer EUL (Oracle Applications 
schema)

APPS

DISCOINSTALL The directory where Discoverer 4i is 
installed

D:\ORANT\DISCV
R4

DISCOHOST TNS alias of the EDW database which hosts 
Discoverer 4i EDW EUL

 tst115
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Below is an example of generate_eex.bat file settings:

@set ORAINSTALL=d:\orant
@set OWB_PROJECT="EDWPRJ"
@set OMTST_OWB_CONNECT_FULL=edwrep/edwrep@ap301sun:1521:tst115
@set DISCO_ID=EDWEUL_US
@set DISCO_PASSWD=EDWEUL_US
@set SCHEMA_OWNER=APPS

5. Generate an eex file.

a. a.Log into OWB9.2 Administrative Client machine.

b. b.Execute the <OWB9.2_HOME>\owb\upgrade\generate_eex.bat script

For example:

C:\> cd \OWB92\owb\upgrade
C:\OWB92\owb\upgrade\> generate_eex.bat

c. Check the log files for any errors.

6. Update the EDW EUL.

a. Log into the Discoverer 4i Administrative Client machine.

b. Copy the <OWB9.2_HOME>\owb\upgrade directory and generated eex 
file from the OWB9.2 Administrative Client machine into a temporary 
directory on the Discoverer 4i Administrative Client machine.

.

DISCO_FILE Predefined EEX file name  edweul.eex

OWB_PROJECT EDW OWB Project Name EDWPRJ

OMTST_OWB_
CONNECT_FULL

OWB9.2 specific EDW Repository connect 
string

String format:
username/password
@host:port:sid

Important: If you have installed both OWB 9.2 and Discoverer 4i 
software on the same machine you don't need to perform the 
previous step. You will use <OWB9.2_HOME>\owb\upgrade 
directory to perform the steps c and d.

Table 3–3 Actual Values

Parameter Name Description Example
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c. Execute the update_EUL.bat script.

For example, if Discoverer 4i is installed on a separate machine:

C:\> cd \TEMP\UPGRADE
C:\TEMP\UPGRADE\> update_EUL.bat

For example, if Discoverer 4i and OWB9i are installed on the same machine:

C:\> cd \OWB903\owb\UPGRADE
C:\\OWB903\owb\UPGRADE\> update_EUL.bat

d. Check the log files for errors.

Upgrade EDW EUL
Upgrade the EDW EUL only if you are upgrading from EDW Release 4.x / OWB 9i 
(9.0.3).

1. Generate the EDW EUL EEX as follows:

a. Log into the OWB Administrative Client machine and run OWB as an 
owner of the EDW OWB repository schema. For example, 
EDWREP/EDWREP@TST115.

b. Select project named EDWPRJ from the list of available projects.

c. From the Projects menu, choose Metadata Export > Bridge. The CWM 
Transfer Wizard appears. Configure the wizard to generate the EDW EUL. 
When using the wizard, ensure that "Oracle Discoverer" is the selected 
target product on "Metadata Source and Target Identification" window and 
that the following values are provided for the "CWM Transfer Parameters" 
window.

2. Import the EEX file as follows:

a. Copy the edweul.eex file to the Discoverer4i Administration Client 
machine.

b. Run Discoverer Administration Client and connect as the EUL owner. For 
example, EDWEUL_US.

c. Choose Import from the File menu.

d. Choose edweul.eex from the list of values and choose Add.

e. Ensure that you select the Import option shown in Figure 3-xx, "Oracle 
Discoverer 4i End User Layer Import Parameters".
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f. Choose Start. The import process begins.

g. After the import is over, click the Finish button and wait until SQL 
regeneration is done.

Upgrade Custom Workbooks
If you have any custom workbooks, upgrade them after you convert or upgrade the 
EDW EUL.

1. Log into the Discoverer 4i Administrative Client machine.

2. Start Discoverer 4i User Edition and open a custom workbook.

3. Validate the custom workbook by name.

4. Save the workbook in the database.

5. Repeat steps 1 through 4 for each custom workbook.

Configure Security
Configure security for your workbooks by completing the following steps.

■ Grant Users/Responsibilities Access to Business Areas on page 2-29

■ Transfer EDW Discoverer 4i Contents to Windows NT/2000/XP Client on 
page 2-30

Create OWB 9.2 Metadata Repository
This section describes how to create a new OWB9.2 Repository using Oracle 9.2 
Warehouse Builder Repository Assistant. 

1. Start the Oracle Warehouse Builder Repository Assistant. 
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Create OWB 9.2 Metadata Repository
Figure 3–7 Welcome window

2. Click Next. The Server and SYSDBA Information window appears.
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Figure 3–8 Server and SYSDBA window

3. Click Next. The Create or Drop window appears.
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Figure 3–9 Create or Drop window

4. Choose the Create a new Warehouse Builder Repository option and click Next. 
The New or Existing Schema window appears.
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Figure 3–10 New or Existing Schema window

5. Choose the “Create and install into new user schema” option and click Next. 
The Username and Password (New) window appears. 
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Figure 3–11 User Name and Password (New) window

6. Enter the following information:

User Name: edwrep 

Password: <edwrep user password>

Click Next. The Tablespace window appears.
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Figure 3–12 Tablespace window

7. Chose the default data tablespace for EDWREP database schema from the 
"Select the tablespace for data" list of values.

8. Chose the default index tablespace for EDWREP database schema from the 
"Select the tablespace for indexes" list of values.

9. Chose the temporary tablespace for EDWREP database schema from the "Select 
the tablespace for temporary data" list of values.

10. Chose the default tablespace for snapshots for EDWREP database schema from 
the "Select the tablespace for snapshots" list of values. Click the Next button to 
continue. The Define Languages window appears.
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Figure 3–13 Define Languages window

11. Choose "American English" from the "Choose MLS base language" list of 
values. Click Next to continue. The Summary window appears.
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Figure 3–14 Summary window

12. The Summary window contains a list of all the selections you have made. 
Verify that the OWB repository setup information is correct.

a. If the setup information is incorrect, click the Back button until you reach 
the appropriate screen and re-enter the correct values. Click the Next 
button repeatedly until you return to the Summary window.

b. If the set up information is correct, choose the Finish button. The Embedded 
Data Warehouse schema is created and installed in your warehouse.

Your new OWB 9.2 Metadata Repository is now installed.
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